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GETTING STARTED GUIDE

NI USRP-29xx
Universal Software Radio Peripheral

This document explains how to install, configure, and test the National Instruments universal
software radio peripheral (USRP) 2920, 2921, 2922, 2930, 2932, 2940R, 2942R, 2943R,
2950R, 2952R, or 2953R (NI 29xx) device. The NI USRP-29xx can send and receive signals
for use in various communications applications. This device ships with the NI-USRP
instrument driver, which you can use to program the device.

To access NI USRP-29xx documentation, navigate to Start»All Programs»
National Instruments»NI-USRP»Documentation.
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Electromagnetic Compatibility Guidelines
This product was tested and complies with the regulatory requirements and limits for
electromagnetic compatibility (EMC) stated in the product specifications. These requirements
and limits provide reasonable protection against harmful interference when the product is
operated in the intended operational electromagnetic environment.

This product is intended for use in industrial locations. However, harmful interference may
occur in some installations, when the product is connected to a peripheral device or test object,
or if the product is used in residential or commercial areas. To minimize interference with
radio and television reception and prevent unacceptable performance degradation, install and
use this product in strict accordance with the instructions in the product documentation.

Furthermore, any changes or modifications to the product not expressly approved by National
Instruments could void your authority to operate it under your local regulatory rules.

Caution  To ensure the specified EMC performance, operate this product only with
shielded cables and accessories.

Caution  To ensure the specified EMC performance, the length of all I/O cables
except for that connected to the GPS antenna input must be no longer than
3 m (10 ft).

Caution  This product is not approved or licensed for transmission over the air
using an antenna. As a result, operating this product with an antenna may violate
local laws. Ensure that you are in compliance with all local laws before operating
this product with an antenna.
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Quick Start Steps
1. Choose whether to use the device as a PCI Express device or as an Ethernet device.

Note  NI 294x/295x devices support both PCI Express and Ethernet bus
connections. All other devices support only Ethernet.

2. Install the driver software media.

3. Connect the device.
• Ethernet connection—Keep the computer powered on. Attach the antenna or cable to

the front panel terminals of the NI USRP-29xx device as desired. Connect the device
directly to your computer with the included Ethernet cable and connect the power.

• PCI Express connection—Power off the computer and the device. Connect the
device to an MXI Express interface on your computer. Power on the device before
powering on your computer. Attach the antenna or cable to the front panel terminals
of the NI USRP-29xx device as desired.

Note  Do not connect a single device to both MXI Express and Ethernet.

4. Configure your computer.
• Ethernet connection—Change the IP address of your standard Ethernet port to a

static IP. NI recommends a static IP address of 192.168.10.1.
• PCI Express connection—Identify your device in Measurement & Automation

Explorer (MAX) and note its RIO resource name. Optionally, create an alias for
your device.

5. (Optional) Update the firmware using the NI-USRP Configuration Utility. If you are
programming the device through the NI-USRP application programming interface (API)
and you need to update the firmware, select Start»All Programs»National
Instruments»NI-USRP»NI-USRP Configuration Utility to open the NI-USRP
Configuration Utility. On the N2xx/NI-29xx Image Updater tab, click Browse to select
a firmware image.

6. Run an example VI or sample project.

If you have trouble with any of the preceding steps, refer to the detailed sections of this guide.

Related Information
Installing the Software on page 7
Installing NI 29xx Devices on page 7
Updating Device Firmware and FPGA Images on page 14
Programming the NI 29xx on page 19
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Verifying the System Requirements
To use the NI-USRP instrument driver, your system must meet certain requirements.

For more information about minimum system requirements, recommended system, and
supported application development environments (ADEs), refer to the product readme, which
is available on the driver software media or online at ni.com/updates.

Unpacking the Kit
Caution  To prevent electrostatic discharge from damaging the device, ground
yourself using a grounding strap or by holding a grounded object, such as your
computer chassis.

1. Touch the antistatic package to a metal part of the computer chassis.
2. Remove the device from the package and inspect the device for loose components or any

other sign of damage.

Caution  Never touch the exposed pins of connectors.

Notify NI if the device appears damaged in any way. Do not install a damaged device.
3. Unpack any other items and documentation from the kit.

Store the device in the antistatic package when the device is not in use.

Preparing the Environment
Ensure that the environment you are using the NI USRP device in meets the following
specifications.

............................................................................Operating temperature -40 °C to 70 °C

............................................................................Operating humidity 10% to 90% RH, noncondensing

............................................................................Pollution Degree 2

............................................................................Maximum altitude 2,000 m

Indoor use only.

Note  Refer to the NI USRP device specifications on ni.com/manuals for complete
specifications.

Caution  Do not operate the device in a manner not specified in this document.
Product misuse can result in a hazard. You can compromise the safety protection
built into the product if the product is damaged in any way. If the product is
damaged, return it to National Instruments for repair.
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Verifying the Kit Contents

LINK
PWR

TX OUTPUT MAX +20 dBm, RX INPUT MAX -15 dBm, ALL RF PORTS 50 W

TX1  RX1 RX2
GPS

PPSREF
TX1  RX1 RX2

AUX I/O
3.3 VDC MAX

RF 0

RF 1

NI USRP-2943R1.2 GHz - 6 GHz

NI USRP-2943R1.2 GHz - 6 GHz

Designed by Ettus Research
Designed by Ettus Research

JTAG

21 3

654 7

1. NI 29xx device
2. AC/DC power supply and power cable
3. Shielded Ethernet cable (included only in NI 292x/

293x kits)
4. SMA (m)-to-SMA (m) cable

5. 30 dB SMA attenuator
6. Driver software media
7. NI USRP-29xx Getting Started Guide (this

document)

Caution  If you directly connect or cable a signal generator to your device, or if
you connect multiple NI USRP devices together, you must connect a 30 dB
attenuator to the RF input (RX1 or RX2) of each receiving NI USRP device.

Note  The driver software media installs the NI-USRP driver software and
electronic documentation, including the NI-USRP Help, the NI-USRP Readme, and
device specifications. After installation, you can find these documents at Start»All
Programs»National Instruments»NI-USRP»Documentation.

Other Required Items
In addition to the kit contents, you must provide the following additional items:
• Computer with available gigabit Ethernet interface.
• If you plan to connect to the device using PCI Express, you need an MXI Express

interface card, such as the NI PCIe-8371.
• One or more of the recommended antennas shown in the following table.
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Table 1. Recommended Antennas

Device Antenna NI Part
Number

   NI USRP-2920/2922/2930/2932/2940R/2942R/2950R/2952R VERT 400—
144 MHz,
400 MHz, and
1,200 MHz tri-
band vertical
antenna

781915-01

NI USRP-2921/2922/2932/2942R/2943R/2952R/2953R VERT 2450—
2.4 GHz to
2.48 GHz and
4.9 GHz to
5.9 GHz to
5.9 GHz dual-
band vertical
antenna

781913-01

Caution  This product is not approved or licensed for transmission over the air
using an antenna. As a result, operating this product with an antenna may violate
local laws. Ensure that you are in compliance with all local laws before operating
this product with an antenna.

Optional Items
• LabVIEW Modulation Toolkit (MT), included on the driver software media, which

includes MT VIs and functions, examples, and documentation

Note  You must install the LabVIEW Modulation Toolkit for proper operation
of the NI-USRP Modulation Toolkit example VIs.

• LabVIEW Digital Filter Design Toolkit, included on the driver software media
• LabVIEW MathScript RT Module, included on the driver software media
• NI USRP-29xx multiple-input multiple-output (MIMO) sync and data transfer cable,

available at ni.com, to synchronize clock sources
• Additional SMA (m)-to-SMA (m) cables to connect both channels with external devices

under test (DUTs) or to use the REF IN and PPS IN signals
• GPS antenna for devices with GPS disciplined oscillator (GPSDO) support
• NI PCIe - MXI Express Interface Kit for USRP RIO to connect to a desktop computer
• NI ExpressCard Slot - MXI Express Interface Kit for USRP RIO to connect to a laptop

computer
• NI PXIe - MXI Express Interface Kit for USRP RIO to connect to a PXI Express chassis
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Installing the Software
You must be an Administrator to install NI software on your computer.
1. Install an ADE, such as LabVIEW or LabWindows™/CVI™.
2. Insert the driver software media into your computer. The installer should open

automatically.

If the installation window does not appear, navigate to the drive, double-click it, and
double-click autorun.exe.

3. Follow the instructions in the installation prompts.

Note  Windows users may see access and security messages during
installation. Accept the prompts to complete the installation.

4. When the installer completes, select Restart in the dialog box that asks if you want to
restart, shut down, or restart later.

Installing NI 29xx Devices
Install all the software you plan to use before you install the hardware.

Note  The NI USRP device connects to a host computer using either a standard
gigabit Ethernet interface or an MXI Express device. Refer to the documentation for
your gigabit Ethernet interface or your MXI Express device for installation and
configuration instructions.

1. Power off the computer if necessary.
• PCI Express connection—Power off the computer and the NI USRP device. Power

on the NI USRP device before powering on your computer.
• Ethernet connection—Keep the computer powered on.

2. Attach the antenna or cable to the front panel terminals of the NI USRP device as desired.
3. Use the Ethernet cable or MXI Express interface card to connect the NI USRP device to

the computer. For maximum throughput over Ethernet, NI recommends that you connect
each NI USRP device to its own dedicated gigabit Ethernet interface on the host
computer.

Note  Do not connect a single NI USRP device to both MXI Express and
Ethernet.

4. Connect the AC/DC power supply to the NI USRP device.
5. Plug the power supply into a wall outlet. For NI 294x/295x devices, you must also press

the PWR button. If your computer was powered off, you can now power on the computer.
Windows automatically recognizes the NI USRP device.

Related Information
Updating USRP N2xx/NI 29xx Firmware and FPGA Images on page 14

NI USRP-29xx Getting Started Guide | © National Instruments | 7



Configuring NI 29xx Devices

Setting Up the Network (Ethernet Only)
The device communicates with a host computer over gigabit Ethernet. Set up the network to
enable communication with the device.

Note  The IP addresses for the host computer and each connected NI USRP device
must be unique.

Related Information
Configuring Multiple Devices with Ethernet on page 11

Configure the Host Ethernet Interface with a Static IP Address
The default IP address for the NI 29xx is 192.168.10.2. You must configure the host
Ethernet interface with a static IP address on the same subnet as the connected device to
enable communication, as shown in the following table.

Table 2. Static IP Addresses

Component Address

  Host Ethernet interface static IP address 192.168.10.1

Host Ethernet interface subnet mask 255.255.255.0

Default NI USRP device IP address 192.168.10.2

Note  NI-USRP uses user datagram protocol (UDP) broadcast packets to locate the
device. On some systems, the firewall blocks UDP broadcast packets.
NI recommends that you change or disable the firewall settings to allow
communication with the device.

Tip  Make sure the host computer uses a static IP address. You may need to modify
the network settings for the local area connection using the Control Panel on the host
computer. Specify the static IP address in the Properties page for Internet Protocol
Version 4 (TCP/IPv4).

Related Information
Changing the IP Address on page 8

Changing the IP Address
To change the NI 29xx device IP address, you must know the current address of the device,
and you must configure the network.
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1. Verify that your device is powered on and connected to your computer using the gigabit
Ethernet interface.

2. Select Start»All Programs»National Instruments»NI-USRP»NI-USRP
Configuration Utility to open the NI-USRP Configuration Utility.

3. Select the Change IP Address tab of the utility.

Your device should appear in the list on the left side of the tab.
4. In the list, select the device for which you want the change the IP address.

If you have multiple devices, verify that you selected the correct device.
The IP address of the selected device displays in the Selected IP Address textbox.

5. Enter the new IP address for the device in the New IP Address textbox.

The utility should appear similar to the following figure.
Figure 1. Changing the IP Address

6. Click the Change IP Address button or press <Enter> to change the IP address.

The IP address of the selected device displays in the Selected IP Address textbox.
7. The utility prompts you to confirm your selection. Click OK if your selection is correct;

otherwise, click Cancel.
8. The utility displays a confirmation to indicate the process is complete. Click OK.
9. Power cycle the device to apply the changes.

NI USRP-29xx Getting Started Guide | © National Instruments | 9



10. After you change the IP address, you must power cycle the device and click Find Devices
in the utility to update the list of devices.

Confirming Network Connection
1. Select Start»All Programs»National Instruments»NI-USRP»NI-USRP

Configuration Utility to open the NI-USRP Configuration Utility.
2. Select the Change IP Address tab of the utility.

Your device should appear in the list on the left side of the tab, similar to the following
figure.

Figure 2. Confirm Network Connection

Note  If your device is not listed, verify that your device is powered on and
correctly connected, then click the Find Devices button to scan for NI USRP
devices. Your device should appear in the list on the left side of the tab.

Related Information
Changing the IP Address on page 8
The Device Does Not Connect to the Host Ethernet Interface on page 21
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Configuring Multiple Devices with Ethernet
You can connect multiple devices in the following ways:
• Multiple Ethernet interfaces—One device for each interface
• Single Ethernet interface—One device connected to the interface, with additional devices

connected using an optional MIMO cable
• Single Ethernet interface—Multiple devices connected to an unmanaged switch

Tip  Sharing a single gigabit Ethernet interface among devices may reduce overall
signal throughput. For maximum signal throughput, NI recommends that you
connect no more than one device per Ethernet interface.

Multiple Host Ethernet Interfaces

To configure multiple devices connected to separate gigabit Ethernet interfaces, assign each
Ethernet interface a separate subnet, and assign the corresponding device an address in that
subnet, as shown in the following table.

Table 3. Multiple Host Ethernet Interface Configuration

Device Host IP Address Host Subnet Mask Device IP Address

    NI USRP Device 0 192.168.10.1 255.255.255.0 192.168.10.2

NI USRP Device 1 192.168.11.1 255.255.255.0 192.168.11.2

Single Host Ethernet Interface—MIMO

You can configure multiple devices using a single host Ethernet interface when the devices are
connected to each other using a MIMO cable. Assign each device a separate IP address in the
subnet of the host Ethernet interface, as shown in the following table. Connect Device 0 to the
Ethernet interface and connect Device 1 to Device 0 using a MIMO cable.

Table 4. Single Host Ethernet Interface—MIMO Configuration

Device Host IP Address Host Subnet Mask Device IP Address

    NI USRP Device 0 192.168.10.1 255.255.255.0 192.168.10.2

NI USRP Device 1 192.168.10.1 255.255.255.0 192.168.10.3

Single Host Ethernet Interface—Unmanaged Switch

You can connect multiple NI USRP devices to a host computer through an unmanaged gigabit
Ethernet switch that allows a single gigabit Ethernet adapter on the computer to interface with
multiple NI USRP devices connected to the switch. Assign the host Ethernet interface a
subnet, and assign each device an address in that subnet, as shown in the following table.
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Table 5. Single Host Ethernet Interface—Unmanaged Switch Configuration

Device Host IP Address Host Subnet Mask Device IP Address

    NI USRP Device 0 192.168.10.1 255.255.255.0 192.168.10.2

NI USRP Device 1 192.168.10.1 255.255.255.0 192.168.10.3

Related Information
Setting Up the Network (Ethernet Only) on page 8

Using the Optional NI ExpressCard Slot - MXI Express
Interface Kit for USRP RIO to Connect to a Laptop
Computer
Laptop computers are not grounded, so you must complete the following steps to safely
connect a laptop computer to your NI USRP device:

Note  The ExpressCard Interface Kit can be used only with NI 294x/295x devices.

1. Ensure the NI USRP device is plugged in and powered off.
2. Touch the NI ExpressCard-8360B and outer metal case of the NI USRP device

simultaneously.
3. Connect the cable to the NI ExpressCard-8360B and NI USRP device.
4. Plug the NI ExpressCard-8360B into an available ExpressCard slot. If your laptop

computer is already running or hibernating when you install an NI ExpressCard-8360B,
you must restart to detect the NI USRP device. Otherwise, the NI USRP device is
detected when you start your computer.
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Figure 3. Connecting the Express Card to a Laptop Computer

4

2

1

3

1. Cable included with ExpressCard Interface Kit
2. NI ExpressCard-8360B

3. ExpressCard Slot
4. Laptop Computer

Using the Optional NI PCIe - MXI Express Interface Kit
for USRP RIO to Connect to a Desktop Computer
1. Power down your NI 294x/295x device.
2. Power down your desktop computer.
3. Follow the installation instructions in the Hardware Installation section of the Set Up

Your MXI™ Express ×4 System document included in the kit to install the NI PCIe-8371.
4. Connect the NI 8371 to the to the NI 294x/295x using the included cable.
5. Power on the NI USRP device.
6. Power on the desktop computer.

Related Information
Refer to the Set Up Your MXI™ Express ×4 System printed document

Using the Optional NI PXIe - MXI Express Interface Kit
for USRP RIO to Connect to a PXI Express Chassis
1. Power down your NI 294x/295x device.
2. Power down your PXI Express chassis.
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3. Follow the installation instructions in the Hardware Installation section of the Set Up
Your MXI™ Express ×4 System document included in the kit to install the NI PXIe-8374.

4. Connect the NI 8374 to the to the NI 294x/295x using the included cable.
5. Power on the NI 294x/295x device.
6. Power on the PXI Express chassis.

Related Information
Refer to the Set Up Your MXI™ Express ×4 System printed document

Updating Device Firmware and FPGA Images
NI 29xx devices ship with firmware and FPGA images compatible with NI-USRP driver
software. You may need to update the device for compatibility with the latest version of the
software.

When you use the NI-USRP API, a default FPGA loads from persistent storage on the device.

To use NI-USRP with Ettus Research USRP N2xx and USRP2 devices, you may need to
update the device firmware and FPGA images. If you have used the USRP N2xx and USRP2
devices with GNU Radio, you may not have compatible images. Refer to www.ettus.com
for more information about Ettus Research devices.

The driver software media also includes the NI-USRP Configuration Utility, which you can
use to update the devices.

Note  If you are using an NI 294x/295x device as a LabVIEW FPGA target, do not
update firmware and FPGA images. Instead, use a sample project as a starting point
to create a custom FPGA.

Related Information
Updating USRP N2xx/NI 29xx Firmware and FPGA Images on page 14
Updating USRP2 Firmware and FPGA Images on page 17
NI-USRP Sample Projects on page 19

Updating USRP N2xx/NI 29xx Firmware and FPGA
Images
The firmware and FPGA images for the USRP N2xx and NI 29xx devices are stored in the
device internal memory. You can program the device over the network to update or change the
firmware and FPGA images.
1. If connected to the device using Ethernet, verify that the host Ethernet interface is

configured correctly.
2. Select Start»All Programs»National Instruments»NI-USRP»NI-USRP

Configuration Utility to open the NI-USRP Configuration Utility.
3. Select the N2xx/NI-29xx Image Updater tab. The utility should automatically populate

the Firmware Image and FPGA Image fields with the paths to the default firmware and
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FPGA image files. If you want to use different files, click the Browse button next to the
file you want to change, and navigate to the file you want to use.

4. The utility updates the firmware and FPGA images in a single operation. Verify that the
firmware and FPGA image paths are entered correctly. The utility should appear similar
to the following figure.

Figure 4. N2xx/NI-29xx Image Updater

5. Click the Find Devices button to scan for USRP devices and update the device list.

If your device does not appear in the list, verify that the device is on and is correctly
connected to the computer.
If your device still does not appear in the list, you can manually add the device to the list.
Click the Manually Add Device button, enter the IP address of the device in the dialog
box that displays, and click OK. The manually added device appears in the device list,
similar to the following figure.
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Figure 5. Manually Added Device

6. Select the device to update from the device list, and verify that you selected the correct
device.

7. Verify that the version of the FPGA image file matches the board revision for the device
you are updating. On Ettus devices, locate the board revision on a label on the back of the
device.

8. To update the device, click the WRITE IMAGES button.
9. A confirmation dialog box displays. Confirm your selections and click OK to continue.

A progress bar indicates the status of the update.
10. When the update completes, a dialog box prompts you to reset the device. A device reset

applies the new images to the device. Click OK to reset the device.

Note  The utility is unresponsive while it verifies that the device reset
correctly.

11. Close the utility.
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12. For NI 292x/293x devices only—verify that the D LED is lit on the device front panel to
confirm that the firmware and FPGA images loaded successfully.

Related Information
Refer to the Load the images onto the on-board flash (USRP-N Series only) section of the
UHD - USRP2 and N Series Application Notes
Installing NI 29xx Devices on page 7

Updating USRP2 Firmware and FPGA Images
The firmware and FPGA images for the USRP2 device are stored on a secure digital (SD)
card. After you power on the USRP2, the device loads firmware and FPGA images from the
SD card plugged into the SD card slot.

Note  NI recommends you use the SD card that shipped with the USRP2 device.
Compatibility issues may result if you use a third-party SD card. However, the
following SD cards are compatible:
• Patriot Signature 2 GB SD Flash Card Model PSF2G40SD
• Kingston 2 GB SD Flash Card W/E Tail Clamshell Model SD/2GBET

Note  To update the USRP2 device firmware and FPGA images, you must use an
SD card interface with read/write capability, such as the IOGEAR GFR281.

Caution  If the SD card interface prompts you to format the disk, click Cancel. Do
not format the disk.

1. Verify that the host Ethernet interface is configured correctly.
2. Insert the SD card from your device in the SD card interface connected to your system.
3. Select Start»All Programs»National Instruments»NI-USRP»NI-USRP

Configuration Utility to open the NI-USRP Configuration Utility.
4. Select the USRP2 SD Card Burner tab.

The utility should automatically populate the Firmware Image and FPGA Image fields
with the paths to the default firmware and FPGA image files.

5. Optionally, if you want to use different files, click the Browse button next to the file you
want to change, and navigate to the file you want to use.

6. Verify that the firmware and FPGA image paths are entered correctly because the utility
updates both files in the same operation.

The utility should appear similar to the following figure.
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Figure 6. USRP2 SD Card Burner

7. Click the Refresh Device List button, and select the drive letter that corresponds to the
SD card interface connected to your computer. If the drive letter for the SD card interface
does not appear in the list, verify that the SD card interface appears in My Computer and
the SD card is inserted in the SD card interface.

Caution  Ensure that you select the correct drive letter to update.

8. Click the WRITE IMAGES button or press <Enter> to write the firmware and images
to your SD card.

A progress bar indicates the status of the update.
9. Click OK to close the dialog box that displays to indicate the completion of the update.
10. Close the utility.
11. Return the SD card to the USRP2 device.
12. Power cycle the USRP2 device.
13. Verify that the D LED is lit on the device front panel to confirm that the firmware and

FPGA images loaded successfully.
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Programming the NI 29xx
You can use the NI-USRP instrument driver with all NI USRP devices. Use the NI-USRP
instrument driver to create communications applications for the NI 29xx.

Some devices (NI 2940R/2942R/2943R/2950R/2952R/2953R) are LabVIEW FPGA targets,
which support creating custom FPGAs and configuring the device using Instrument Design
Libraries. For these devices, use a sample project as a starting point for application
development.

NI-USRP Instrument Driver
NI-USRP features a set of VIs and properties that exercise the functionality of the NI 29xx,
including configuration, control, and other device-specific functions. Refer to the
NI-USRP Help for information about using the instrument driver in your applications.

NI-USRP Examples
The instrument driver examples are instructional tools that demonstrate some of the
functionality of the NI 29xx. You can use these examples separately or integrate them into
your systems. NI-USRP includes examples for getting started and other SDR functionality.
You can access the NI-USRP examples from the following locations:
• From the Start menu at Start»All Programs»National Instruments»NI-USRP»

Examples.
• From the LabVIEW Functions palette at Instrument I/O»Instrument Drivers»

NI‑USRP»Examples.

You can access additional examples from the code sharing community at ni.com/usrp.

Note  The NI Example Finder does not include NI-USRP examples.

NI-USRP Sample Projects
The NI-USRP software contains sample projects that are a starting point for application
development. You can open the projects in LabVIEW by selecting
File»Create Project»NI-USRP.

You must install the LabVIEW FPGA Module to customize the behavior of the device FPGA.

NI USRP-29xx Getting Started Guide | © National Instruments | 19



Troubleshooting
If an issue persists after you complete a troubleshooting procedure, contact NI technical
support or visit ni.com/support.

Device Troubleshooting

The NI USRP Device Does Not Appear in MAX
MAX supports only NI 294x/295x devices configured with a PCI Express connection. If you
are using an NI USRP 292x/293x device, or if you are using an NI 294x/295x device
configured with an Ethernet connection, use the NI-USRP Configuration Utility instead. Open
the NI-USRP Configuration Utility from the Start menu at Start»All Programs»National
Instruments»NI-USRP»NI-USRP Configuration Utility.

The Device Does Not Power On
If you are using an NI 292x/293x device, check the power supply by substituting a different
adapter. If you are using an NI 294x/295x device, you can also check that the power switch on
the front of the device is engaged.

The Device Does Not Appear in the NI-USRP Configuration
Utility
If connecting with an MXI Express cable, ensure that the NI USRP device is powered on and
connected to a computer before you power on the computer.

If connecting with Ethernet, ensure the NI USRP device is connected to a computer with a
gigabit-compatible Ethernet adapter. Next, ensure that a static IP address of 192.168.10.1
is assigned to the adapter in your computer. Allow up to 15 seconds for the device to
completely start up.

In the NI-USRP Configuration Utility, USRP2 Appears Instead of
NI-29xx
An incorrect IP address on the computer may cause this error. Check the IP address and run
the NI-USRP Configuration Utility again.

An old FPGA or firmware image on the device may also cause this error. Upgrade the FPGA
and firmware using the NI-USRP Configuration Utility.

The NI-USRP Palette Does Not Appear in LabVIEW (64-Bit)
NI-USRP runs only in LabVIEW (32-bit). Use LabVIEW (32-bit) instead.

NI-USRP Examples Do Not Appear in the NI Example Finder
NI-USRP does not install examples into the NI Example Finder.
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You can access the NI-USRP examples from the following locations:
• From the Start menu at Start»All Programs»National Instruments»NI-USRP»

Examples.
• From the LabVIEW Functions palette at Instrument I/O»Instrument Drivers»

NI‑USRP»Examples.

Network Troubleshooting

The Device Does Not Connect to the Host Ethernet Interface
The host Ethernet interface must be a gigabit Ethernet interface to connect to the NI USRP
device. Ensure the connection between the host network interface card and the device cable
connection is valid and both the device and computer are powered on. A lit green LED in the
upper left corner of the gigabit Ethernet connection port on the device front panel indicates a
gigabit Ethernet connection.

The Device Does Not Respond to a Ping (ICMP Echo Request)
The device should reply to an internet control message protocol (ICMP) echo request. Open a
Windows command prompt and enter ping 192.168.10.2, where 192.168.10.2 is the
IP address for your NI USRP device, to ping the device. If you do not receive a response,
verify that the host network interface card is set to a static IP address corresponding to the
same subnet as the IP address of the corresponding device. Also verify that the device IP
address is set properly.

Related Information
Changing the IP Address on page 8

The NI-USRP Configuration Utility Does Not Return a Listing for
My Device
If the NI-USRP Configuration Utility does not return a listing for your device, search for a
specific IP address.
1. Navigate to <Program Files>\National Instruments\NI-USRP\.
2. <Shift>-right-click the utilities folder, and select Open command window here

from the shortcut menu to open a Windows command prompt.
3. Enter uhd_find_devices --args=addr=192.168.10.2 in the command prompt,

where 192.168.10.2 is the IP address for your NI USRP device.
4. Press <Enter>.

If the uhd_find_devices command does not return the listing for your device, the
firewall may be blocking replies to UDP broadcast packets. Windows installs and enables
a firewall by default. To allow UDP communication with a device, disable any firewall
software associated with the network interface for the device.
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The Device IP Address Does Not Reset to the Default
If you cannot reset the default device IP address, your device may be on a different subnet than
the host network adapter. You can power cycle the device in a safe (read-only) image, which
sets the device to the default IP address of 192.168.10.2.
1. Open the device enclosure, making sure to take appropriate static precautions.
2. Locate the safe-mode button, a push-button switch (S2), inside the enclosure.
3. Press and hold the safe-mode button while you power cycle the device.
4. Continue to press the safe-mode button until the front-panel LEDs blink and remain solid.
5. While in safe-mode, run the NI-USRP Configuration Utility to change the IP address

from the default, 192.168.10.2, to a new value.
6. Power cycle the device without holding the safe-mode button to return the normal mode.

Note  NI recommends that you use a dedicated network with no other USRP
devices connected to the host computer to avoid the possibility of an IP address
conflict. Also, verify that the static IP address of the host network adapter on
the computer that runs the NI-USRP Configuration Utility is different from the
device default IP address of 192.168.10.2 and different from the new IP
address to which you want to set the device.

Note  If the device IP address is on a different subnet from the host network
adapter, the host system and configuration utility cannot communicate with and
configure the device. For example, the utility recognizes, but cannot configure a
device with an IP address of 192.168.11.2 connected to a host network
adapter with a static IP address of 192.168.10.1 and a subnet mask of
255.255.255.0. To communicate with and configure the device, change the
host network adapter to a static IP address on the same subnet as the device,
such as 192.168.11.1, or change the subnet mask of the host network
adapter to recognize a wider range of IP addresses, such as 255.255.0.0.

Related Information
Changing the IP Address on page 8

Front Panels, Back Panels, and Connectors

NI USRP-2920
Figure 7. NI USRP-2920 Front Panel
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Table 6. NI USRP-2920 Module Front Panel Connectors

Connector Use

  RX1

TX1

Input and output terminal for the RF signal. RX1 TX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or
output channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

REF IN Input terminal for an external reference signal for the local oscillator
(LO) on the device. REF IN is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended reference input. REF IN
accepts a 10 MHz signal with a minimum input power of 0 dBm
(.632 Vpk-pk) and a maximum input power of 15 dBm (3.56 Vpk-pk) for
a square wave or sine wave.

PPS IN Input terminal for the pulse per second (PPS) timing reference.
PPS IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended input. PPS IN accepts 0 V to 3.3 V TTL and 0 V to 5 V
TTL signals.

MIMO
EXPANSION

The MIMO EXPANSION interface port connects two NI USRP
devices using a compatible MIMO cable.

GB ETHERNET The gigabit Ethernet port accepts an RJ-45 connector and gigabit
Ethernet compatible cable (Category 5, Category 5e, or Category 6).

POWER The power input accepts a 6 V, 3 A external DC power connector.

Table 7. NI USRP-2920 Module LEDs

LED Indication

  A Indicates the transmit status of the module:
OFF—The module is not transmitting data.
GREEN—The module is transmitting data.

B Indicates the status of the physical MIMO cable link:
OFF—The modules are not connected using the MIMO cable.
GREEN—The modules are connected using the MIMO cable.
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Table 7. NI USRP-2920 Module LEDs (Continued)

LED Indication

  C Indicates the receive status of the module:
OFF—The module is not receiving data.
GREEN—The module is receiving data.

D Indicates the firmware status of the module:
OFF—The firmware is not loaded.
GREEN—The firmware is loaded.

E Indicates the reference lock status of the LO on the module:
OFF—There is no reference signal, or the LO is not locked to a reference signal.
BLINKING—The LO is not locked to a reference signal.
GREEN—The LO is locked to a reference signal.

F Indicates the power status of the module:
OFF—The module is powered off.
GREEN—The module is powered on.

NI USRP-2921
Figure 8. NI USRP-2921 Front Panel
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Table 8. NI USRP-2921 Module Front Panel Connectors

Connector Use

  RX1

TX1

Input and output terminal for the RF signal. RX1 TX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or
output channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.
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Table 8. NI USRP-2921 Module Front Panel Connectors (Continued)

Connector Use

  REF IN Input terminal for an external reference signal for the local oscillator
(LO) on the device. REF IN is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended reference input. REF IN
accepts a 10 MHz signal with a minimum input power of 0 dBm
(.632 Vpk-pk) and a maximum input power of 15 dBm (3.56 Vpk-pk) for
a square wave or sine wave.

PPS IN Input terminal for the pulse per second (PPS) timing reference.
PPS IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended input. PPS IN accepts 0 V to 3.3 V TTL and 0 V to 5 V
TTL signals.

MIMO
EXPANSION

The MIMO EXPANSION interface port connects two NI USRP
devices using a compatible MIMO cable.

GB ETHERNET The gigabit Ethernet port accepts an RJ-45 connector and gigabit
Ethernet compatible cable (Category 5, Category 5e, or Category 6).

POWER The power input accepts a 6 V, 3 A external DC power connector.

Table 9. NI USRP-2921 Module LEDs

LED Indication

  A Indicates the transmit status of the module:
OFF—The module is not transmitting data.
GREEN—The module is transmitting data.

B Indicates the status of the physical MIMO cable link:
OFF—The modules are not connected using the MIMO cable.
GREEN—The modules are connected using the MIMO cable.

C Indicates the receive status of the module:
OFF—The module is not receiving data.
GREEN—The module is receiving data.

D Indicates the firmware status of the module:
OFF—The firmware is not loaded.
GREEN—The firmware is loaded.
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Table 9. NI USRP-2921 Module LEDs (Continued)

LED Indication

  E Indicates the reference lock status of the LO on the module:
OFF—There is no reference signal, or the LO is not locked to a reference signal.
BLINKING—The LO is not locked to a reference signal.
GREEN—The LO is locked to a reference signal.

F Indicates the power status of the module:
OFF—The module is powered off.
GREEN—The module is powered on.

NI USRP-2922
Figure 9. NI USRP-2922 Front Panel
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Table 10. NI USRP-2922 Module Front Panel Connectors

Connector Use

  RX1

TX1

Input and output terminal for the RF signal. RX1 TX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or
output channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

REF IN Input terminal for an external reference signal for the local oscillator
(LO) on the device. REF IN is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended reference input. REF IN
accepts a 10 MHz signal with a minimum input power of 0 dBm
(.632 Vpk-pk) and a maximum input power of 15 dBm (3.56 Vpk-pk) for
a square wave or sine wave.
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Table 10. NI USRP-2922 Module Front Panel Connectors (Continued)

Connector Use

  PPS IN Input terminal for the pulse per second (PPS) timing reference.
PPS IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended input. PPS IN accepts 0 V to 3.3 V TTL and 0 V to 5 V
TTL signals.

MIMO
EXPANSION

The MIMO EXPANSION interface port connects two NI USRP
devices using a compatible MIMO cable.

GB ETHERNET The gigabit Ethernet port accepts an RJ-45 connector and gigabit
Ethernet compatible cable (Category 5, Category 5e, or Category 6).

POWER The power input accepts a 6 V, 3 A external DC power connector.

Table 11. NI USRP-2922 Module LEDs

LED Indication

  A Indicates the transmit status of the module:
OFF—The module is not transmitting data.
GREEN—The module is transmitting data.

B Indicates the status of the physical MIMO cable link:
OFF—The modules are not connected using the MIMO cable.
GREEN—The modules are connected using the MIMO cable.

C Indicates the receive status of the module:
OFF—The module is not receiving data.
GREEN—The module is receiving data.

D Indicates the firmware status of the module:
OFF—The firmware is not loaded.
GREEN—The firmware is loaded.
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Table 11. NI USRP-2922 Module LEDs (Continued)

LED Indication

  E Indicates the reference lock status of the LO on the module:
OFF—There is no reference signal, or the LO is not locked to a reference signal.
BLINKING—The LO is not locked to a reference signal.
GREEN—The LO is locked to a reference signal.

F Indicates the power status of the module:
OFF—The module is powered off.
GREEN—The module is powered on.

NI USRP-2930
Figure 10. NI USRP-2930 Front Panel
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Table 12. NI USRP-2930 Module Front Panel Connectors

Connector Use

  RX1

TX1

Input and output terminal for the RF signal. RX1 TX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or
output channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with
an impedance of 50 Ω and is a single-ended input channel.

REF IN This terminal is not used for this device.

PPS IN Input terminal for the PPS timing reference. PPS IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input
channel. PPS IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL
signals.

MIMO EXPANSION The MIMO EXPANSION interface port connects two USRP devices
using a compatible MIMO cable.
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Table 12. NI USRP-2930 Module Front Panel Connectors (Continued)

Connector Use

  GB ETHERNET The gigabit Ethernet port accepts an RJ-45 connector and gigabit
Ethernet compatible cable (Category 5, Category 5e, or Category 6).

POWER The power input accepts a 6 V, 3 A external DC power connector.

Table 13. NI USRP-2930 Module LEDs

LED Indication

  A Indicates the transmit status of the module:
OFF—The module is not transmitting data.
GREEN—The module is transmitting data.

B Indicates the status of the physical MIMO cable link:
OFF—The modules are not connected using the MIMO cable.
GREEN—The modules are connected using the MIMO cable.

C Indicates the receive status of the module:
OFF—The module is not receiving data.
GREEN—The module is receiving data.

D Indicates the firmware status of the module:
OFF—The firmware is not loaded.
GREEN—The firmware is loaded.

E Indicates the reference lock status of the LO on the module:
OFF—There is no reference signal, or the LO is not locked to a reference signal.
BLINKING—The LO is not locked to a reference signal.
GREEN—The LO is locked to a reference signal.

F Indicates the power status of the module:
OFF—The module is powered off.
GREEN—The module is powered on.
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Figure 11. NI USRP-2930 Back Panel

GPS

ANT

GPS ANT is the input terminal for the GPS antenna signal. GPS ANT is an SMA (f) connector
with an impedance of 50 Ω.

NI USRP-2932
Figure 12. NI USRP-2932 Front Panel
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Table 14. NI USRP-2932 Module Front Panel Connectors

Connector Use

  RX1

TX1

Input and output terminal for the RF signal. RX1 TX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or
output channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with
an impedance of 50 Ω and is a single-ended input channel.

REF IN This terminal is not used for this device.

PPS IN Input terminal for the PPS timing reference. PPS IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input
channel. PPS IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL
signals.

MIMO EXPANSION The MIMO EXPANSION interface port connects two USRP devices
using a compatible MIMO cable.
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Table 14. NI USRP-2932 Module Front Panel Connectors (Continued)

Connector Use

  GB ETHERNET The gigabit Ethernet port accepts an RJ-45 connector and gigabit
Ethernet compatible cable (Category 5, Category 5e, or Category 6).

POWER The power input accepts a 6 V, 3 A external DC power connector.

Table 15. NI USRP-2932 Module LEDs

LED Indication

  A Indicates the transmit status of the module:
OFF—The module is not transmitting data.
GREEN—The module is transmitting data.

B Indicates the status of the physical MIMO cable link:
OFF—The modules are not connected using the MIMO cable.
GREEN—The modules are connected using the MIMO cable.

C Indicates the receive status of the module:
OFF—The module is not receiving data.
GREEN—The module is receiving data.

D Indicates the firmware status of the module:
OFF—The firmware is not loaded.
GREEN—The firmware is loaded.

E Indicates the reference lock status of the LO on the module:
OFF—There is no reference signal, or the LO is not locked to a reference signal.
BLINKING—The LO is not locked to a reference signal.
GREEN—The LO is locked to a reference signal.

F Indicates the power status of the module:
OFF—The module is powered off.
GREEN—The module is powered on.
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Figure 13. NI USRP-2932 Back Panel

GPS

ANT

GPS ANT is the input terminal for the GPS antenna signal. GPS ANT is an SMA (f) connector
with an impedance of 50 Ω.

NI USRP-2940R
Figure 14. NI USRP-2940R Front Panel
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Table 16. NI USRP-2940R Module Front Panel Connectors

Connector Use

  JTAG A USB port that connects the host computer to the device FPGA for
development and debugging. LabVIEW FPGA does not currently support
configuring or programming the device FPGA using the JTAG connector.

RF 0 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

AUX I/O General-purpose I/O (GPIO) port. AUX I/O is controlled by the FPGA.
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Table 16. NI USRP-2940R Module Front Panel Connectors (Continued)

Connector Use

  RF 1 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

Note  The LED indications described in the following table occur only when you
use the NI-USRP API with the default FPGA image. When you use LabVIEW
FPGA, you customize the LED indications.

Table 17. NI USRP-2940R Module LEDs

LED Indication

  RF 0 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

REF Indicates the status of the reference signal:
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference signal.

PPS Indicates the pulse per second (PPS):
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference time signal.

GPS Indicates whether the GPSDO is locked:
OFF—There is no GPSDO or the GPSDO is not locked.
GREEN—The GPSDO is locked.
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Table 17. NI USRP-2940R Module LEDs (Continued)

LED Indication

  LINK Indicates the status of the link to a host computer:
OFF—There is no link to a host computer.
GREEN/YELLOW/RED—The host is actively communicating with
the device.

RF 1 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

Figure 15. NI USRP-2940R Module Back Panel
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Table 18. NI USRP-2940R Module Back Panel Connectors

Connector Use

  PWR The power input accepts a 9 V to 16 V, 6 A external DC power connector.

1G/10G ETH The Ethernet ports accept 1G SFP modules and 10G SFP+ modules. With
a 1G ETH module inserted, the ports accept gigabit Ethernet-compatible
cables (Category 5, Category 5e, or Category 6).

REF OUT Output terminal for an external reference signal for the LO on the device.
REF OUT is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference output. REF OUT outputs a 10 MHz signal at
3.3 V.
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Table 18. NI USRP-2940R Module Back Panel Connectors (Continued)

Connector Use

  REF IN Input terminal for an external reference signal for the LO on the device.
REF IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference input. REF IN accepts a 10 MHz signal with a
minimum input power of 0 dBm (.632 Vpk-pk) and a maximum input power
of 15 dBm (3.56 Vpk-pk) for a square wave or sine wave.

PCIe x4 This port accepts a PCI Express Generation 1, x4 bus connection through
an MXI Express four-lane cable.

PPS TRIG
OUT

Output terminal for PPS timing reference. PPS TRIG OUT is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input.
PPS TRIG OUT outputs 0 V to 3.3 V TTL. You can also use this port as a
triggered output (TRIG OUT) that you control using NI-USRP software.

PPS TRIG IN Input terminal for PPS timing reference. PPS TRIG IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input channel.
PPS TRIG IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL signals. You
can also use this port as a triggered input (TRIG IN) that you control using
NI-USRP software.

GPS ANT Input terminal for the GPS antenna signal. GPS ANT is an SMA (f)
connector with a maximum input power of -15 dBm and an output of
DC 5 V to power an active antenna.

Caution  Do not terminate the GPS ANT port if you do not use
it.

NI USRP-2942R
Figure 16. NI USRP-2942R Front Panel
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Table 19. NI USRP-2942R Module Front Panel Connectors

Connector Use

  JTAG A USB port that connects the host computer to the device FPGA for
development and debugging. LabVIEW FPGA does not currently support
configuring or programming the device FPGA using the JTAG connector.

RF 0 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

AUX I/O General-purpose I/O (GPIO) port. AUX I/O is controlled by the FPGA.

RF 1 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

Note  The LED indications described in the following table occur only when you
use the NI-USRP API with the default FPGA image. When you use LabVIEW
FPGA, you customize the LED indications.

Table 20. NI USRP-2942R Module LEDs

LED Indication

  RF 0 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.
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Table 20. NI USRP-2942R Module LEDs (Continued)

LED Indication

  REF Indicates the status of the reference signal:
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference signal.

PPS Indicates the pulse per second (PPS):
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference time signal.

GPS Indicates whether the GPSDO is locked:
OFF—There is no GPSDO or the GPSDO is not locked.
GREEN—The GPSDO is locked.

LINK Indicates the status of the link to a host computer:
OFF—There is no link to a host computer.
GREEN/YELLOW/RED—The host is actively communicating with
the device.

RF 1 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

Figure 17. NI USRP-2942R Module Back Panel
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Table 21. NI USRP-2942R Module Back Panel Connectors

Connector Use

  PWR The power input accepts a 9 V to 16 V, 6 A external DC power connector.

1G/10G ETH The Ethernet ports accept 1G SFP modules and 10G SFP+ modules. With
a 1G ETH module inserted, the ports accept gigabit Ethernet-compatible
cables (Category 5, Category 5e, or Category 6).

REF OUT Output terminal for an external reference signal for the LO on the device.
REF OUT is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference output. REF OUT outputs a 10 MHz signal at
3.3 V.

REF IN Input terminal for an external reference signal for the LO on the device.
REF IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference input. REF IN accepts a 10 MHz signal with a
minimum input power of 0 dBm (.632 Vpk-pk) and a maximum input power
of 15 dBm (3.56 Vpk-pk) for a square wave or sine wave.

PCIe x4 This port accepts a PCI Express Generation 1, x4 bus connection through
an MXI Express four-lane cable.

PPS TRIG
OUT

Output terminal for PPS timing reference. PPS TRIG OUT is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input.
PPS TRIG OUT outputs 0 V to 3.3 V TTL. You can also use this port as a
triggered output (TRIG OUT) that you control using NI-USRP software.

PPS TRIG IN Input terminal for PPS timing reference. PPS TRIG IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input channel.
PPS TRIG IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL signals. You
can also use this port as a triggered input (TRIG IN) that you control using
NI-USRP software.

GPS ANT Input terminal for the GPS antenna signal. GPS ANT is an SMA (f)
connector with a maximum input power of -15 dBm and an output of
DC 5 V to power an active antenna.

Caution  Do not terminate the GPS ANT port if you do not use
it.
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NI USRP-2943R
Figure 18. NI USRP-2943R Front Panel
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Table 22. NI USRP-2943R Module Front Panel Connectors

Connector Use

  JTAG A USB port that connects the host computer to the device FPGA for
development and debugging. LabVIEW FPGA does not currently support
configuring or programming the device FPGA using the JTAG connector.

RF 0 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

AUX I/O General-purpose I/O (GPIO) port. AUX I/O is controlled by the FPGA.

RF 1 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

Note  The LED indications described in the following table occur only when you
use the NI-USRP API with the default FPGA image. When you use LabVIEW
FPGA, you customize the LED indications.
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Table 23. NI USRP-2943R Module LEDs

LED Indication

  RF 0 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

REF Indicates the status of the reference signal:
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference signal.

PPS Indicates the pulse per second (PPS):
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference time signal.

GPS Indicates whether the GPSDO is locked:
OFF—There is no GPSDO or the GPSDO is not locked.
GREEN—The GPSDO is locked.

LINK Indicates the status of the link to a host computer:
OFF—There is no link to a host computer.
GREEN/YELLOW/RED—The host is actively communicating with
the device.
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Table 23. NI USRP-2943R Module LEDs (Continued)

LED Indication

  RF 1 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

Figure 19. NI USRP-2943R Module Back Panel
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Table 24. NI USRP-2943R Module Back Panel Connectors

Connector Use

  PWR The power input accepts a 9 V to 16 V, 6 A external DC power connector.

1G/10G ETH The Ethernet ports accept 1G SFP modules and 10G SFP+ modules. With
a 1G ETH module inserted, the ports accept gigabit Ethernet-compatible
cables (Category 5, Category 5e, or Category 6).

REF OUT Output terminal for an external reference signal for the LO on the device.
REF OUT is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference output. REF OUT outputs a 10 MHz signal at
3.3 V.

REF IN Input terminal for an external reference signal for the LO on the device.
REF IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference input. REF IN accepts a 10 MHz signal with a
minimum input power of 0 dBm (.632 Vpk-pk) and a maximum input power
of 15 dBm (3.56 Vpk-pk) for a square wave or sine wave.

PCIe x4 This port accepts a PCI Express Generation 1, x4 bus connection through
an MXI Express four-lane cable.
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Table 24. NI USRP-2943R Module Back Panel Connectors (Continued)

Connector Use

  PPS TRIG
OUT

Output terminal for PPS timing reference. PPS TRIG OUT is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input.
PPS TRIG OUT outputs 0 V to 3.3 V TTL. You can also use this port as a
triggered output (TRIG OUT) that you control using NI-USRP software.

PPS TRIG IN Input terminal for PPS timing reference. PPS TRIG IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input channel.
PPS TRIG IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL signals. You
can also use this port as a triggered input (TRIG IN) that you control using
NI-USRP software.

GPS ANT Input terminal for the GPS antenna signal. GPS ANT is an SMA (f)
connector with a maximum input power of -15 dBm and an output of
DC 5 V to power an active antenna.

Caution  Do not terminate the GPS ANT port if you do not use
it.

NI USRP-2950R
Figure 20. NI USRP-2950R Front Panel
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Table 25. NI USRP-2950R Module Front Panel Connectors

Connector Use

  JTAG A USB port that connects the host computer to the device FPGA for
development and debugging. LabVIEW FPGA does not currently support
configuring or programming the device FPGA using the JTAG connector.

RF 0 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.
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Table 25. NI USRP-2950R Module Front Panel Connectors (Continued)

Connector Use

  AUX I/O General-purpose I/O (GPIO) port. AUX I/O is controlled by the FPGA.

RF 1 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

Note  The LED indications described in the following table occur only when you
use the NI-USRP API with the default FPGA image. When you use LabVIEW
FPGA, you customize the LED indications.

Table 26. NI USRP-2950R Module LEDs

LED Indication

  RF 0 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

REF Indicates the status of the reference signal:
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference signal.

PPS Indicates the pulse per second (PPS):
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference time signal.
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Table 26. NI USRP-2950R Module LEDs (Continued)

LED Indication

  GPS Indicates whether the GPSDO is locked:
OFF—There is no GPSDO or the GPSDO is not locked.
GREEN—The GPSDO is locked.

LINK Indicates the status of the link to a host computer:
OFF—There is no link to a host computer.
GREEN/YELLOW/RED—The host is actively communicating with
the device.

RF 1 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

Figure 21. NI USRP-2950R Module Back Panel
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Table 27. NI USRP-2950R Module Back Panel Connectors

Connector Use

  PWR The power input accepts a 9 V to 16 V, 6 A external DC power connector.

1G/10G ETH The Ethernet ports accept 1G SFP modules and 10G SFP+ modules. With
a 1G ETH module inserted, the ports accept gigabit Ethernet-compatible
cables (Category 5, Category 5e, or Category 6).

REF OUT Output terminal for an external reference signal for the LO on the device.
REF OUT is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference output. REF OUT outputs a 10 MHz signal at
3.3 V.
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Table 27. NI USRP-2950R Module Back Panel Connectors (Continued)

Connector Use

  REF IN Input terminal for an external reference signal for the LO on the device.
REF IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference input. REF IN accepts a 10 MHz signal with a
minimum input power of 0 dBm (.632 Vpk-pk) and a maximum input power
of 15 dBm (3.56 Vpk-pk) for a square wave or sine wave.

PCIe x4 This port accepts a PCI Express Generation 1, x4 bus connection through
an MXI Express four-lane cable.

PPS TRIG
OUT

Output terminal for PPS timing reference. PPS TRIG OUT is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input.
PPS TRIG OUT outputs 0 V to 3.3 V TTL. You can also use this port as a
triggered output (TRIG OUT) that you control using NI-USRP software.

PPS TRIG IN Input terminal for PPS timing reference. PPS TRIG IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input channel.
PPS TRIG IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL signals. You
can also use this port as a triggered input (TRIG IN) that you control using
NI-USRP software.

GPS ANT Input terminal for the GPS antenna signal. GPS ANT is an SMA (f)
connector with a maximum input power of -15 dBm and an output of
DC 5 V to power an active antenna.

Caution  Do not terminate the GPS ANT port if you do not use
it.

NI USRP-2952R
Figure 22. NI USRP-2952R Front Panel
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Table 28. NI USRP-2952R Module Front Panel Connectors

Connector Use

  JTAG A USB port that connects the host computer to the device FPGA for
development and debugging. LabVIEW FPGA does not currently support
configuring or programming the device FPGA using the JTAG connector.

RF 0 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

AUX I/O General-purpose I/O (GPIO) port. AUX I/O is controlled by the FPGA.

RF 1 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

Note  The LED indications described in the following table occur only when you
use the NI-USRP API with the default FPGA image. When you use LabVIEW
FPGA, you customize the LED indications.

Table 29. NI USRP-2952R Module LEDs

LED Indication

  RF 0 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.
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Table 29. NI USRP-2952R Module LEDs (Continued)

LED Indication

  REF Indicates the status of the reference signal:
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference signal.

PPS Indicates the pulse per second (PPS):
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference time signal.

GPS Indicates whether the GPSDO is locked:
OFF—There is no GPSDO or the GPSDO is not locked.
GREEN—The GPSDO is locked.

LINK Indicates the status of the link to a host computer:
OFF—There is no link to a host computer.
GREEN/YELLOW/RED—The host is actively communicating with
the device.

RF 1 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

Figure 23. NI USRP-2952R Module Back Panel
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Table 30. NI USRP-2952R Module Back Panel Connectors

Connector Use

  PWR The power input accepts a 9 V to 16 V, 6 A external DC power connector.

1G/10G ETH The Ethernet ports accept 1G SFP modules and 10G SFP+ modules. With
a 1G ETH module inserted, the ports accept gigabit Ethernet-compatible
cables (Category 5, Category 5e, or Category 6).

REF OUT Output terminal for an external reference signal for the LO on the device.
REF OUT is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference output. REF OUT outputs a 10 MHz signal at
3.3 V.

REF IN Input terminal for an external reference signal for the LO on the device.
REF IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference input. REF IN accepts a 10 MHz signal with a
minimum input power of 0 dBm (.632 Vpk-pk) and a maximum input power
of 15 dBm (3.56 Vpk-pk) for a square wave or sine wave.

PCIe x4 This port accepts a PCI Express Generation 1, x4 bus connection through
an MXI Express four-lane cable.

PPS TRIG
OUT

Output terminal for PPS timing reference. PPS TRIG OUT is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input.
PPS TRIG OUT outputs 0 V to 3.3 V TTL. You can also use this port as a
triggered output (TRIG OUT) that you control using NI-USRP software.

PPS TRIG IN Input terminal for PPS timing reference. PPS TRIG IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input channel.
PPS TRIG IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL signals. You
can also use this port as a triggered input (TRIG IN) that you control using
NI-USRP software.

GPS ANT Input terminal for the GPS antenna signal. GPS ANT is an SMA (f)
connector with a maximum input power of -15 dBm and an output of
DC 5 V to power an active antenna.

Caution  Do not terminate the GPS ANT port if you do not use
it.
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NI USRP-2953R
Figure 24. NI USRP-2953R Front Panel
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Table 31. NI USRP-2953R Module Front Panel Connectors

Connector Use

  JTAG A USB port that connects the host computer to the device FPGA for
development and debugging. LabVIEW FPGA does not currently support
configuring or programming the device FPGA using the JTAG connector.

RF 0 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

AUX I/O General-purpose I/O (GPIO) port. AUX I/O is controlled by the FPGA.

RF 1 TX1 RX1 Input and output terminal for the RF signal. TX1 RX1 is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input or output
channel.

RX2 Input terminal for the RF signal. RX2 is an SMA (f) connector with an
impedance of 50 Ω and is a single-ended input channel.

Note  The LED indications described in the following table occur only when you
use the NI-USRP API with the default FPGA image. When you use LabVIEW
FPGA, you customize the LED indications.
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Table 32. NI USRP-2953R Module LEDs

LED Indication

  RF 0 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

REF Indicates the status of the reference signal:
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference signal.

PPS Indicates the pulse per second (PPS):
OFF—There is no reference signal or the device is not locked to the
reference signal.
BLINKING—The device is not locked to the reference signal.
GREEN—The device is locked to the reference time signal.

GPS Indicates whether the GPSDO is locked:
OFF—There is no GPSDO or the GPSDO is not locked.
GREEN—The GPSDO is locked.

LINK Indicates the status of the link to a host computer:
OFF—There is no link to a host computer.
GREEN/YELLOW/RED—The host is actively communicating with
the device.
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Table 32. NI USRP-2953R Module LEDs (Continued)

LED Indication

  RF 1 TX1/
RX1

Indicates the transmit status of the module:
OFF—The module is not active.
RED—The module is receiving data.
GREEN—The module is transmitting data.

RX2 Indicates the receive status of the module:
OFF—The module is not receiving.
GREEN—The modules is receiving.

Figure 25. NI USRP-2953R Module Back Panel
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Table 33. NI USRP-2953R Module Back Panel Connectors

Connector Use

  PWR The power input accepts a 9 V to 16 V, 6 A external DC power connector.

1G/10G ETH The Ethernet ports accept 1G SFP modules and 10G SFP+ modules. With
a 1G ETH module inserted, the ports accept gigabit Ethernet-compatible
cables (Category 5, Category 5e, or Category 6).

REF OUT Output terminal for an external reference signal for the LO on the device.
REF OUT is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference output. REF OUT outputs a 10 MHz signal at
3.3 V.

REF IN Input terminal for an external reference signal for the LO on the device.
REF IN is an SMA (f) connector with an impedance of 50 Ω and is a
single-ended reference input. REF IN accepts a 10 MHz signal with a
minimum input power of 0 dBm (.632 Vpk-pk) and a maximum input power
of 15 dBm (3.56 Vpk-pk) for a square wave or sine wave.

PCIe x4 This port accepts a PCI Express Generation 1, x4 bus connection through
an MXI Express four-lane cable.
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Table 33. NI USRP-2953R Module Back Panel Connectors (Continued)

Connector Use

  PPS TRIG
OUT

Output terminal for PPS timing reference. PPS TRIG OUT is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input.
PPS TRIG OUT outputs 0 V to 3.3 V TTL. You can also use this port as a
triggered output (TRIG OUT) that you control using NI-USRP software.

PPS TRIG IN Input terminal for PPS timing reference. PPS TRIG IN is an SMA (f)
connector with an impedance of 50 Ω and is a single-ended input channel.
PPS TRIG IN accepts 0 V to 3.3 V TTL and 0 V to 5 V TTL signals. You
can also use this port as a triggered input (TRIG IN) that you control using
NI-USRP software.

GPS ANT Input terminal for the GPS antenna signal. GPS ANT is an SMA (f)
connector with a maximum input power of -15 dBm and an output of
DC 5 V to power an active antenna.

Caution  Do not terminate the GPS ANT port if you do not use
it.
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Where to Go Next
Refer to the following figure for information about other product tasks and associated
resources for those tasks.

Tip  The NI-USRP Help is an HTML version of a traditional user manual that
includes detailed information about RF fundamentals, device features, and
programming with NI-USRP.

Worldwide Support and Services
The National Instruments website is your complete resource for technical support. At ni.com/
support you have access to everything from troubleshooting and application development self-
help resources to email and phone assistance from NI Application Engineers.

Visit ni.com/services for NI Factory Installation Services, repairs, extended warranty, and
other services.
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Visit ni.com/register to register your National Instruments product. Product registration
facilitates technical support and ensures that you receive important information updates from
NI.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the
European Communities using the manufacturer’s declaration of conformity. This system
affords the user protection for electromagnetic compatibility (EMC) and product safety. You
can obtain the DoC for your product by visiting ni.com/certification. If your product supports
calibration, you can obtain the calibration certificate for your product at ni.com/calibration.

National Instruments corporate headquarters is located at 11500 North Mopac Expressway,
Austin, Texas, 78759-3504. National Instruments also has offices located around the world.
For telephone support in the United States, create your service request at ni.com/support or
dial 512 795 8248. For telephone support outside the United States, visit the Worldwide
Offices section of ni.com/niglobal to access the branch office websites, which provide up-to-
date contact information, support phone numbers, email addresses, and current events.

Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for information on National Instruments trademarks.
Other product and company names mentioned herein are trademarks or trade names of their respective companies. For patents
covering National Instruments products/technology, refer to the appropriate location: Help»Patents in your software, the
patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents. You can find information about
end-user license agreements (EULAs) and third-party legal notices in the readme file for your NI product. Refer to the Export
Compliance Information at ni.com/legal/export-compliance for the National Instruments global trade compliance policy and
how to obtain relevant HTS codes, ECCNs, and other import/export data.
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